
Garden Planner Version 3 Help Manual

Getting Started

Garden Planner is a tool that lets you easily design your dream garden. 

You can arrange plants, trees, buildings and objects using an easy to use 'drag and drop' interface. 

Then produce a high quality color image or print out of your design.

When you first start Garden Planner you will see a welcome message, click the 'Start with a New 

Plan' button and then you are ready to start designing your garden plan.

Overview of the Application

Garden Planner is made up of eight main parts;

(1) the Menu: at the very top of the application are the menu options. 

File | View | Settings | Add | Selected Object | Help

This works like a menu in any application, just click on any menu item and a list of options appears 

below. For example this Help Manual can be accessed from the Help menu item.

(2) the Toolbar: below the menu is the tool bar, which is a row of buttons that allow you to quickly 

perform common actions. 



Here's what each button does;

New Plan: create a new Garden Plan, when you click this a message box will 
appear asking you to confirm that you want to create a new plan (NB: creating a 
new plan will erase your existing plan)

Open a MyPlans: open the My Plans window. Which shows a list of all the plans 
you have created and stored in My Plans

Save your Plan: save your garden plan. If you haven't previously saved your plan 
then you will be asked to provide a name for your plan. If you have already 
saved your plan then this will save the plan with the last used name. If you want 
to save a copy of your plan or save it under a new name use the Save As... option
from the File menu. Garden Planner plans are saved with the file extension gml.

Print: print your plan. Clicking this button opens the preview window, which lets 
you set your printing preferences and then print your plan.

Undo and Redo: The undo button lets you undo an action eg: if didn't mean to 
delete a plant, click undo to get the plant back. The undo button allows you undo
the last 50 actions. You can undo moving, resizing, rotating and deleting objects. 
The redo button lets you undo an undo. For example: if you clicked the undo 
button unintentionally you can fix it by clicking redo. When using the drawing 
tools, while you are drawing out your shape (wall, paving etc) you can use undo 
to remove the last click (last added corner).

Select/Move: this sets the way in which objects on the plan can be moved and 
modified. Either the Select, Scale or Rotate button can be selected to determine 
how objects can be moved or modified. With the Select button selected, objects 
on the plan can be moved but not scaled or rotated. (see selecting multiple 
objects below for details on selecting more than one object)

Resize: With the Resize button selected objects on the plan can be scaled (ie: you 
can change their size).

Rotate: With the Rotate button selected objects on the plan can be rotated but not
moved.

Rotate 90 degrees counterclockwise: rotates the currently selected object 90 
degrees counterclockwise

Rotate 90 degrees clockwise: rotates the currently selected object 90 degrees 
clockwise.



Send to the Back: this affects the stacking order (depth) of the currently selected 
object. This moves the object to the bottom off all objects on the plan, irrespective
of the type of object.

Send to the Front: this affects the stacking order (depth) of the currently selected 
object. This moves the object to the top off all objects on the plan, irrespective of 
the type of object.

Duplicate: duplicates the currently selected object on the plan. If no object is 
currently selected then this does nothing.

Delete: deletes the currently selected object. If no object is currently selected then 
this does nothing.

Add Label: This lets you easily add labels to your plan. Just click the button to 
create a label and then click on the grid to place it on your plan. When you select
the label you will be able to adjust it's text, size etc in the properties panel.

Add Veg. Bed: This opens a tool that lets you easily create vegetable or herb 
garden beds. See creating vegetable beds below

Shadows: this button can be on or off. It determines if shadows are shown under 
plants and objects, which can help to add a sense of depth to your plan.

Maximise Grid: maximize the design area. If you are working on a large plan (or 
a low resolution computer) this can be helpful. It hides the toolbar and objects 
panel and makes the grid space larger. 



(3) the Objects Panel: on the left side of the application are the 

Objects and Tools Panels. You can view the objects panel by clicking 

on the objects tab. When you first start Garden Planner the objects 

panel should already be visible. 

The Objects Panel is where you find the library of all the plants and 

other garden objects that you use to create your plan. 

Simply click on an object select it from the panel and click to place it 

onto the grid to start creating your garden plan. 

The objects are organized into a number of categories to make it 

faster and simpler to find specific objects. When you start Garden 

Planner the Shrubs category is selected. 

You can change the category by clicking on the menu at the top of the

Objects Panel and selecting a different category from the menu. 

Use the scrollbar on the side of the Objects Panel to scroll through the

objects.



(4) the Tools Panel: on the left side of the application are the Objects 

and Tools Panels. You can view the Tools Panel by clicking on the tools 

tab. 

The Tools Panel is where you will find a number of tools designed to 

help you in creating your garden plan. 

To select a tool click on one of the blue tool icons in the bottom half of

the tool panel. The currently selected tool will appear pink.

Most tools work in the same basic way:

First you select the style for

the tool 

eg: the style of fence or style

of paving or style of garden

bed. 

To choose the style for the

tool click on the blue style

button, this will open a panel

that shows a number of

different styles (as shown to

the right).

You can then click on any one of the styles to select it.
For example: if you are using the garden beds tool you could pick a 

style that looks like sand, dirt or grass and choose if it had a border.



Once you have selected a style you then click on one of the four drawing mode buttons.

You select either a straight line or a curved line or a shape (square) or freehand drawing.

You then click on the plan to start drawing the line/s.

 when drawing straight lines click once on the grid to start the line. Click again to draw 

another line extending from the first line. Double click to end the line. Garden Planner will now draw

the path, fence, garden bed etc that matches the line you drew. Use this button to draw rectangular 

garden beds, paving and straight fences or paths. Once you have completed the drawing you can 

easily adjust it's shape, including adding curves to straight lines. (If you accidentally click in the 

wrong spot and want to undo you last click use the undo command (Ctrl +Z ) or Undo button to 

remove the last corner)

 when drawing curved lines click once on the grid to start the line. Click again to draw 

another line extending from the first line - this line will curve based on the position of the previous 

click. Double click to end the line. Garden Planner will now draw the path, fence, garden bed etc 

that matches the line you drew. Use this button to draw curved paths.

 when drawing shapes click on the grid and hold the mouse button

down. Move the mouse to draw the shape. Release the mouse button to

complete the shape. Use this button to draw quickly rectangular garden

beds and paving. 

The default shape is a rectangle/square. To change the shape move the

mouse over this button and you will see buttons for drawing a circle and a

rectangle with rounded corners (as shown to the right). You can select

these to change the type of shape you are drawing.

 when drawing freehand lines click on the grid and hold the mouse button down. Move the 

mouse to draw the line. Release the mouse button to stop drawing.

The scrollbar on the side of the Tools Panel allows you to scroll through the tools.

Garden beds: this tool will create a garden bed or lawn. Select one 

of the drawing buttons and draw a shape on the grid. When you 

finish the tool will convert the shape to a garden bed. The color of 

the garden bed may be changed using the properties panel. You can 

also change the style of the garden bed using the change style button

on the properties panel.



Wall and Fence builder: this tool will create a fence or wall on the 

plan. Select one of the drawing buttons and draw a line on the grid. 

When you finish the tool will convert the line to a fence. If you have 

selected a style with fence posts the posts will be evenly spaced with 

the addition of fence posts at any corners in the drawing. The color of

the fence may be changed using the properties panel. You can also 

change the style of the fence using the change style button on the 

properties panel.

Paving and Decking builder: this tool will create a section of paving 

or decking on the plan. Select one of the drawing buttons and draw 

a shape on the grid. When you finish the tool will convert the shape 

to paving/decking. The color of the pacing may be changed using 

the properties panel. You can also change the style of the paving 

using the change style button on the properties panel.

Path builder: this tool will create a path on the plan. Select one of the

drawing buttons and draw a line on the grid. When you finish the 

tool will convert the line to a path. If you have selected a style with 

stones or paving square then the stones will be evenly spaced along 

the path. The color of the path may be changed using the properties 

panel. You can also change the style of the path using the change 

style button on the properties panel.

Pools and Ponds: this tool will create a swimming pool or pond. 

Select one of the drawing buttons and draw a shape on the grid. 

When you finish the tool will convert the shape to a pool. The color of

the pool may be changed using the properties panel. You can also 

change the style of the pool using the change style button on the 

properties panel.

Gravel and Stones: this tool will create a section of gravel or stone 

paving on the plan. Select one of the drawing buttons and draw a 

shape on the grid. When you finish the tool will convert the shape to 

a gravel. The color of the gravel may be changed using the 

properties panel. You can also change the style of the gravel using 

the change style button on the properties panel.



Edge builder: this tool will create a garden bed edge on the plan. 

Select one of the drawing buttons and draw a line on the grid. When 

you finish the tool will convert the line to edging. If you have selected 

a style with stones or bricks then the stones will be evenly spaced 

along the path. The color of the path may be changed using the 

properties panel. You can also change the style of the path using the 

change style button on the properties panel.

Shade Area: this tool will create a shade area: a transparent shape 

on the plan. Select one of the drawing buttons and draw a shape on 

the grid. When you finish the tool will convert the shape to the shade 

area. The color of the shade area may be changed using the 

properties panel. You can also change the style of the shade area 

using the change style button on the properties panel.

Irrigation Hoses: this tool allows you to draw irrigation hoses on your 

plan. Select one of the drawing buttons and draw a line on the grid. 

When you finish the tool will convert the line to a hose. The color of 

the hose may be changed using the properties panel. You can also 

change the style of the hose using the change style button on the 

properties panel.

Measurement Lines: this tool allows you to add lines showing 

distances on your plan. Select one of the drawing buttons and draw a

line on the grid. When you finish the tool will convert the line to a 

measurement line. The color of the line may be changed using the 

properties panel. You can also change the style of the line using the 

change style button on the properties panel.

Lines and Arrows: this tool allows you to draw simple lines and 

arrows on your plan. Select one of the drawing buttons and draw a 

line on the grid. When you finish the tool will convert the line to the 

style of line (or arrow) that you have chosen. The color of the line 

may be changed using the properties panel. You can also change the

style of the line using the change style button on the properties panel.



Shapes and Textures: this tool will create a simple shape in either a 

solid color or with a texture. It is similar to the garden bed tool. Select

one of the drawing buttons and draw a shape on the grid. When you

finish the tool will convert fill in the shape with the color or texture 

you have chosen. The color of the shape area may be changed using

the properties panel. You can also change the style of the shape area

using the change style button on the properties panel..

Vines and Ivy: this tool allows you to draw vines and ivy on your plan.

Select one of the drawing buttons and draw a line on the grid. When 

you finish the tool will convert the line to a vine style selected. The 

color of the vine may be changed using the properties panel. You can

also change the style of the vine using the change style button on the 

properties panel.

Decorations: this tool allows you to draw decorations such as strings 

of lights and bunting on your plan. Select one of the drawing buttons 

and draw a line on the grid. When you finish the tool will convert the 

line to a decoration style selected. The color of the decoration may be

changed using the properties panel. You can also change the style of 

the decoration using the change style button on the properties panel.

Kitechen Benches : this tool allows you to draw kitchen bench tops. It 

is similar to drawing walls.Select one of the drawing buttons and 

draw a line on the grid. When you finish the tool will convert the line 

to the bench style selected. The color of the bench may be changed 

using the properties panel. You can also change the style of the 

bench using the change style button on the properties panel. Extra 

changes to the look of the bench may also be made in the 3d view. 

(5) the Grid: this is where you create your plan. Simply click and drag objects from the Objects 
Panel and drop them onto the grid to create your plan. The size of the grid can be changed from the
Grid Settings option under the Settings menu. If the size of the grid is larger than your application 
window then scroll bars will appear to allow you to access the full grid. 

At the bottom of the grid is the grid toolbar (shown above). 

The first button lets you set the size of the grid. This can also be done by choosing Grid settings from

the settings menu. 

The second button on this toolbar lets you choose to hide or show the grid.

The third button lets you choose to hide or show rulers at the top and left hand side of the grid. 

The fourth button lets you choose to show or hide the properties window. 



Next is the Layers button. Clicking this will show a window that lets

you adjust the display layers in the plan (see right).

The layers window lets you hide or show different parts of your

plan. This can be useful if want make adjustments to one part of

the plan but find that other objects are getting in the way. eg: say

you want to modify the paving in your plan but trees and flowers

that appear on top of the paving are making it hard to adjust the

shape of the paving. Then just hide the layers above the paving

while you make the adjustments and then show them again when

you are finished.

The Outline and Transparent check boxes allow you to set specific

parts of you plan to display as just an outline or as transparent (see through). This can be useful if 

you want to be able to see objects that are under bigger objects - eg: see plants and flowers that sit 

under a large tree.

There are two list buttons on the tool bar. The first list lets you select what units are used in the plan 

(either metric - meters or US - feet). The second list allows you to quickly change the zoom level of 

the plan.

The buttons with the plus and minus sign will zoom in or out of the grid by a small amount. This can

be a quick way to zoom in or out. 

 

(6) the Properties Panel: when you first start Garden Planner the Properties Panel is not visible, it will 

appear when you select an object on the grid. 

The Properties Panel shows the properties for the currently selected object. If no object is selected 

then the Properties Panel is hidden. You can also force the properties panel to be hidden by clicking 

on the P button in the grid toolbar. 

You can move the Properties Panel by clicking and dragging the top edge of the panel. You can 

move the panel anywhere, which can be useful when building large plans.



Let's look at the different sections of the Properties Panel:

width and length: the text boxes labelled width and length display the width and length of the 
currently selected object. By default these values are shown in US measurements (feet and inches), 
however you can easily change this to metric measurements using the units menu (bottom right 
corner of the application). Typing a new value into these text boxes will resize the selected object to 
that value.

height: changing the height value will not change the appearance of your plan. Infact you can think 
of height as an optional value. When planning a garden it provides a way to keep a record of the 
height of trees, fences etc in your garden. 

x and y: the text boxes labeled x and y display the position of the currently selected object. The 
values are measured in either feet or meters, with a value of 0,0 being the top left corner of the grid.
The x value is the horizontal position, and the y value value is the vertical position. Increasing the x 
value will move the selected object to the right, increasing the y value will move the selected object 
down. 

rot (rotation): the text box labelled rot displays the rotation of the currently selected object. The 
rotation is displayed in degrees. Increasing the rotation value will rotate the object clockwise. The 
graphic below the rotation text box shows the rotation represented as a line, similar to a compass 
needle eg: if the rotation is 90 degrees then the line will point to the right.

Title: the text box labelled Title displays the title or name for the currently selected object. Each object
that you add to your plan has a default title which you can change to anything you want. 

Lock in place: the lock in place check box allows you to lock the position of an object, preventing it 
from being moved until you unlock it. Checking the lock in place check box for an object means that
you cant move that object until you uncheck the check box. This can be very useful when laying out 
a plan as it prevents you from accidentally moving an object when you are laying out other objects. 

Show Auto Label: the show auto label check box allows you to automatically add a label to the plan 
for the selected plant or object. So, if you select this check box a label will appear just below the 
selected plant or object. The label will display the objects title. This can be a lot easier and faster 
way to label plants in your plan rather than creating new labels from the tool bar. The auto label is 
linked to its associated plant or objects. So if you move the plant or object it's label moves with it.
However you can also move the label itself. Simply drag the label to where you want it to be, it will 
still be linked to it's plant or object. This can be useful if the default position for an auto label 
obscures some other part of your plan. 
From the Settings menu you can choose Auto Label Settings to adjust the font size of auto labels and
if they have a white background behind them or not.
An objects auto label is temporarily hidden when you move an object so that the label doesn't 
obscure where you are positioning your object.

Show in plant list: the show in plant list lets you determine if an object will be listed in the plant and 
object list for your plan.
The plant and object list can be found be clicking on the Notebook tab and then clicking the Plant 
and Object list button. Most items on your plan are included in this list be default, the main 



exception is labels, which aren't included.

Notes: add a Garden Note:this lets you create a garden note associated with this plant. see garden 

notes below

Total Area/Length: If you have used the tools to create either a garden bed, 

a paving area, pool or a gravel/stones area then the properties panel will 

display the Total Area covered by that shape. This is the area covered by the 

shape measured in square feet or square meters.

Change Style: If you have used the tools to create the selected object, then 
when you select that object you will be able to change the style of the 
selected object using the properties panel. Click on the change style button 
and it will display the style selection for that type of object.

Settings: For fences, walls and paths you will 
also see a button called Settings.
Click on this button to show the settings options 
for the selected object (as shown on the right).

The settings option lets you change the width of 
the fence/wall/path and if the fence has posts it 
will also allow you to change the distance 
between posts. For paths that are made up of 
multiple pavers then you will have the option to 
change the distance between each paver. 

Label Properties: The properties panel looks quite different if you have 

selected a label.

The text box at the top of the properties panel is where you type the text

that appears on the label. The color button lets you change the color of

the text.

The button labelled B lets you make the text appear bold and the 

button labelled I lets you make the text appear italic.

The three buttons to the right of the Italic button with the lines on them, 

allow you to set the alignment of the label text. Either aligned to the 

left, to the center or to the right. The slider below the word Size: can be

dragged to change the size of the text in the selected label.

The Color panel: the color panel lets you change the color of the currently selected object. Click the 



colored square to display the color panel (as shown). The color panel is made up of two tabbed 
views: 

The palette view (as shown) which lets you select the color from a palette 

of different colors. Just click on a colored square in the palette to change 

to that color. 

The boxes at the bottom of the palette show you the currently selected 

color with slight variations, from slightly lighter through to slightly darker. 

This can be useful if you just want to slightly adjust the brightness of the 

current color.

The button in the bottom right corner of the color panel lets you select a 

color from your plan. If you click on this button the cursor will change to 

the pipette symbol and when you click on anything on your plan the color 

of that object will be set as the selected color.

And the gradient view (as shown) which lets you set the color by just 

moving the mouse over the large gradient image. As you move over the 

colored gradient the color in the box in the top left corner will change. If 

you click on anywhere on the gradient it will set the color to the 

corresponding color where you clicked. 

At the bottom of the tab is box labeled rgb: This lets you enter a RGB 

value for a color. RGB values are six digit hexadecimal numbers used by 

computers to specify specific colors.

If you wish to close the color panel without changing the color, just click on the colored square.

If the currently selected object has flowers (eg: a flowering shrub) or supports a second color, then a 

second colored square will be visible, allowing you to use another color panel to adjust the color of 

the flowers separate to the color of the plant.



(7) The Preview Window: the preview window can be seen by clicking on the blue preview tab at the 

top of the grid.

The preview window lets you adjust settings before either printing your plan or saving your plan as 

an image.

The preview window shows a preview of how you plan will look when it is printed (or saved as an 

image). This scaled to fill the preview window - when you export as image the image will be the 

exact same size as it is on you plan and not the same size of the scaled preview image.

If you want to adjust the size of the image when exported as an image then click the custom size 

check box and then set the size you want the exported image to be.

If you choose to export the plan in PNG image format you get an extra option that lets you set the 

background as transparent this means that the background of the image will be 'see through' rather 

than white.

At the bottom of the preview window is the settings options (as shown below):

 

Click on the show rulers and show grid lines check boxes if you want rulers or grid lines to appear in

your print out (or saved image). Typically rulers and grid lines are used for layout purposes and so 

you may not want these displayed on your printed/saved image.

The show trees as outlines and show trees as transparent options allow you to change how trees are 

displayed. This can be useful if you have large trees obscuring some of your plan. Making the trees 

transparent (or showing them just as outlines) will allow you to see the objects under the trees. This 

option only affects trees, it doesn't affect shrubs or flowers.

The orientation option allows you to print (or save an image) of the plan rotated 90 degrees. This 

may be useful if you have a very wide plan that you want to print.

The Style option lets you change the visual appearance of the plan. You can either display the plan 

in it's normal style (as it appears in the design view), or light / pastel : which shows the plan in a 

lighter color palette or black & white which displays the plan in black and white and grey.

The Set Print Scale button and Set Print Format button are covered below



Print options: At the top left of the preview window are the print 

options.

If you select include Plant & Object List then as well as printing the 

plan you will also print out a list of all the plants and objects in your 

plan. This list can also be seen in the Notebook window.

If you select include Garden Notes then as well as printing the plan 

you will also print out a list of any garden notes you have added to 

your plan.

If you select show numbers next to plants then you will see numbers 

next to any plants on your plan. These numbers correspond to the 

numbers next to the names of the plants in the plant list.

The print plan over two pages option allows you to create a larger 

version of your plan by printing it across two pages ie: half the plan 

will appear on one page and the other half on the other page

Click on the Print Plan button to print your plan.

Image options: On left of the preview window, under print options 

are the options for exporting as an image.

You can choose the format for the exported image, either Jpeg or 

PNG. PNG is a higher quality format and the best choice if you plan

on including your plan image in a document, power point 

presentation or viewing it in an image editing program.

JPEG is the best choice if you plan to email your plan to someone, 

or put it on the web or share it with friends on a social network site 

like facebook.

By selecting the custom size option you can specify the size of the 

exported image in pixels - this can be useful if you have a small 

plan but want to create a larger image of the plan.



Printing to a Scale:

By default Garden Planner will scale your plan to fill the page of whatever paper you are printing to.

In most cases this will be the best option to pick. However if you want your plan printed to a specific 

scale click on the Set Print Scale button next to the Print Settings options.

Printing to Scale lets you set a 

scale like 1cm on the paper is 

equal to 1m on the plan (or 1inch 

on the paper is equal to 2 feet on 

the plan). To specify a print scale 

first uncheck the Scale Plan to Fit 

Page option. 

Then select the printer you want to

print to. You need to select a 

printer because different printers 

may be printing to different paper 

sizes. If you only have one printer 

then you may not need to select 

this.

Garden Planner will automatically calculate the best possible scale for your plan. The calculation is 

based on making a whole number relationship between the plan and paper scales. What that 

means is that if you are using Metric measurements then it will choose a scale like 1m = 1cm or 1m

= 5cm or 3m =1m (or for US measurements it would be something like 1ft = 1inch or 1ft=5inch or

3ft = 1inch). Garden Planner tries to choose the best scale based on the default paper size for your 

printer.

If you want to you can set your own scale by entering your own values for the plan or paper scale.

If you want Garden Planner to calculate the best scale for a different paper size first change the 

paper selection in your printer settings then click the Set Print Scale button. Typically changing the 

printer paper option can done just be clicking the print button, changing the printer paper settings 

and then cancelling

 the print option. You can then set the print scale and print.

Please Note: printing a plan over two pages is currently not available when printing to scale. If you 

select printing over two pages it will ignore your scale settings.
 

Printing as a vector:

By default Garden Planner sends the image of your plan to the printer as a bitmap. In most cases 

this will be the best option to pick. However if you want your plan printed as a vector click on the Set

Print Format button next to the Print Settings options. Creating a vector image of you plan is useful if 

you want to print to PDF and allow the plan to be scaled or imported into other drawing software. 

For example you could print your plan to PDF (with the format set to vector) and then import that pdf

into a vector based drawing program (like Adobe Illustrator) and then export it to other vector 

formats like DWG or SVG. Please note: Garden Planner doesn't include a print to pdf option 

however all Mac's have this built in, so you can print from any Mac software to PDF. On Windows 



you would need to have some pdf generating software installed (there are both free and commercial

versions of this for Windows). Also note, when printing to pdf bitmap textures (like paving) will stay 

in a bitmap format and also transparent gradient effects on objects may be lost.

(8) The Notebook Window: the notebook window can be seen by clicking on the yellow notebook 

tab at the top of the grid.

The Notebook window provides a list of all the plants and objects used in your plan and list of any 

garden notes you have added to your plan.

Plant and Object list: the plant and object list is a list of all the plants and objects in your plan. You 

can see the plant list by clicking on the Notebook window tab and then clicking on the Plant and 

Object List button at the top of the Notebook window.

Each item in the plant and object list displays the title (or name) as well as the width and length for 

each plant/object.

It also counts identical objects and displays the quantity for each object. For example:if you have 

four bay leaf trees on your plan, the list item for bay leaf tree will have a quantity of 4 rather than 

listing bay bay leaf four times. NB: items are considered identical if they have the same symbol and 

same name.

For Plants, trees, flowers, vegetables and herbs a small representation of the plant is shown next to 

the details for that plant in the plant list. This effectively provides you with a plant key for your plan.

For objects created with the drawing tools, the total area or total length of the object is also shown in

the plant and object list.

At the bottom of the Plant and Object list are three buttons:

Save List as text File: clicking this button will save the plant list as a text (.txt) file that can be opened 

in any text editor or word processor (like Word). NB: plant images are not saved in the text file.

Save List as Table (csv file): clicking this button will save the plant list as a table (.csv file) file that can

be opened in a spreadsheet (like Excel) or a database or imported into a word processor (like Word)

as a table. NB: plant images are not saved in the table.

Save List as Image: clicking this button will save the plant list as an image (jpeg). This can be useful 



if you want to paste the plant list in a document as a key for your plan.

Print: this prints the plant list. You can also print the plant list when printing the plan by choosing the 

include plant and object list option when printing the plan.

Customise: this provides options that let you customise how the plant list appears. You can change 

the colours used and which values are listed within the plant list. If you wish to include height values 

in your plant list this is where you can switch on the display of height in the plant list.

Garden Notes: the Garden Notes are a list of all the garden notes you have created for your plan. 

You can see the garden notes by clicking on the Notebook window tab and then clicking on the 

Garden Notes button at the top of the Notebook window.

 

A new plan will have no garden notes. You can

create new Garden Notes by clicking on the Add a

new Garden Note button.

This will display a message box that allows you to

enter a garden note (see right).

At the top of the message box you can choose to

either associate this garden note with a specific plant

in your plan or just make it a general garden note,

that applies to the whole plan.

You can put whatever information you want in a

Garden Note. You could put in planting notes (eg:

when you planted a tree, or when you should prune it) or botanical information or harvesting dates 

or even just a list of tasks you need to do around the garden.

Once you have created a garden note you can view (and edit) it by clicking on the note in the 

Garden Notes list. You can delete the note by clicking on the word delete in the bottom right corner 

of the note in the notes list.

If you create a note for a specific plant in your plan then you can also see and edit that note by 

clicking on the garden note button in the properties window when you have the plant selected.



At the bottom of the Garden Notes are three buttons:

Save Notes as text File: clicking this button will save the list of all Garden Notes as a text (.txt) file 

that can be opened in any text editor or word processor (like Word). 

Save Notes as Table (csv file): clicking this button will save the list of all Garden Notes as a table 

(.csv file) file that can be opened in a spreadsheet (like Excel) or a database or imported into a word

processor (like Word) as a table. 

Print: this prints all the garden notes. You can also print the garden notes when printing the plan by 

choosing the include Garden Notes option when printing the plan.
 

Menu Items:
New Plan

Create a new plan. This will show the New plan window shown below

When creating a New Plan you can set the name for the plan
(this is what will appear as the plans name in the MyPlans 
window.
You can also change the measurement units that Garden 
Planner uses.
Finally you can choose to Auto save your plan in the My 
Plans folder. This is selected by default.
If this option is selected when you create a new plan it is 
automatically saved to the MyPlans folder. The plan is 
automatically saved every two minutes and also saved when 
you close the plan or Garden Planner. You can also press the
save button at any time to save it.
You can access the plans that you have saved in the MyPlans 
folder simply by clicking on the MyPlans button on the 
toolbar or choosing My Plans from the Garden Planner 
welcome screen. 

What if I don't want to save plans in MyPlans but instead 
somewhere else on my computer?
If you wish to save your plan in a different location just 
uncheck the save to my plans option when you create a new 
plan. You can then choose where to save your plan on your 
computer (eg: on your desktop, network etc)
 
Open My Plans

This will show the MyPlans window that lets you select the plan you wish to open.
You can access the plans that you have saved in the MyPlans folder simply 
by choosing Open My Plans from the File Menu or clicking on the MyPlans
button on the toolbar or choosing My Plans from the Garden Planner 
welcome screen. 
Click on the name of the plan that you want to work on to open it in 
Garden Planner. 
To delete a plan from My Plans click on the X that appears at the end of 
the plans name.
If you want to open a plan from another location on your computer, or on 
a network or cloud drive then use the Browse to a Plan button at the 



bottom of the window.
If instead you want to create a new plan just click on the Create a New 
Plan button at the bottom of the window. 

Saving your Plan

If you have chosen to save your plan in My Plans then the plan will be saved every two minutes 

automatically. It will also be saved when you close Garden Planner or start a new plan.

However you can still force Garden Planner to save the plan by clicking on the Save button on the 

tool bar or choosing Save Plan from the File Menu.

If you have not chosen to save your plan in My Plans then you will need to click the save button to 

save your plan.

Printing

To print your garden plan click on the printer button on the toolbar or choose Print... from the file 

menu. This opens the preview window, which lets you set your printing preferences and then print 

your plan.
Sample Plans

This option displays the folder containing the sample plans. Click on the plan name to open it.
Save a Copy

What if I have a plan in MyPlans but I want to make a copy of it to my desktop (eg: so I can email it 

to someone)?

Open the plan you want to make a copy of and then choose Save a Copy from the the File menu. 

Then choose to Save the Plan to a location on my computer. A window will open letting you choose 

the location and file name you wish to save with. It is recommended that you save the plan with the 

ending (extension) .gml
Export as Image

This feature lets you save the plan as an image. This opens the preview window, which lets you set 

your image preferences and then save an image of your plan.
Copy to Clipboard

This feature will copy an image of your plan to the clipboard. You can then paste that image into a 

document, presentation etc.

For example: to paste a copy of your plan into a Word document.

1. choose Copy to clipboard from the file menu and select OK when the message box is shown.

2. open a Word document or start a new document. 

3. in Word choose Paste - the image of your plan will be pasted into your document.
Import image into Plan

This feature lets you import an image (in either jpg or png format) into your plan. The imported 

image will be placed in the top left hand corner of you plan. It can then be moved and resized like 

any other garden plan object.
Import texture into Tools

This feature lets you import an image (in either jpg or png format) to be used in the Shapes and 

Textures tool. The imported image will be placed in the bottom of the list of Styles for the Shapes and

Textures tool.



The View Menu

The view menu contains options for adjusting the view of your plan.

View Objects: this shows the objects panel. The objects panel can also be shown by clicking on the 

objects tab.

View Tools: this shows the tools panel. The tools panel can also be shown by clicking on the tools 

tab.

Zoom: The zoom... option allows you to set the magnification of the plan as a percentage. For 

example setting it to 200% will double the size of the plan.

Show/Hide Grid: The show/hide grid option toggles the display of the grid on/off.

Show/Hide Rulers: The show/hide rulers option toggles the display of rulers at the top and left hand 

sides of the grid.

Add Triangulation points allows you to add Triangulation points to your plan. Triangulation is a way 

to measure the location of objects in your garden in the real world and then place them in the 

correct locations on your plan.

In the real world choose two fixed points in your garden, say the corners of a wall. These are are 

your triangulation points. Then to find out the location of something in your garden (say a Tree), you

would measure the distance from the tree to the two points. Then when you design your garden in 

Garden Planner you can draw the wall, place the triangulation points at the corners of the wall and 

as you move objects around the plan Garden Planner will show the distance to the two triangulation 

points.

  

  

The Settings Menu

The settings menu contains options for adjusting the settings used by Garden Planner.

General Settings: The general settings.... option allows you to change the main settings used by 

Garden Planner. You can specify if object measurements should be in US feet/inches or metric units. 

Grid Settings: The grid settings.... option allows you to change the settings for the grid. You can set 

the size of the grid, as well as the size of the actual grid squares (ie: how far apart the lines are). 

You can also specify if objects 'snap' to the grid lines. If you check this option then the center of 

objects will always line up with grid lines.

You can also specify if lines created with tools 'snap' to the grid lines. With this option checked the 

start and end of lines will 'snap' to the grid lines which makes it a lot easier to draw lines that are 

perpendicular to each other and hence makes drawing squares and rectangles easier. This option is 

checked by default.

When you start Garden Planner the grid is set to be a standard size. However if this isn't large 

enough for your garden you can resize it to any size you wish. If you make the grid larger than the 

available space on your screen then scroll bars will allow you to access the complete grid. 

You can also choose to overlay the grid lines, which means that the grid lines appear on top of your 

plan.



Ground Settings: The ground settings.... option lets you set a background for your plan. The default 

setting is just a white page with a grid on it. However you may want to design your plan on a 

background of soil, or lawn or paving. Pick the type of background from the four options and then 

select the specific style of lawn, paving etc. When you print your plan or save an image of your plan 

it will show this background under the plan.

Change Scale: The Change Scale

option lets you change the overall

scale of the grid. (see right) This can

be very useful if you find that to see

all of your plan you have to zoom in

or zoom out a lot. By default the scale

used in Garden Planner is about

1:100 which means that one inch ( or

cm) on your screen is equivalent to

about 100 inches (or cm) in the real

world. But if you are designing a

small garden or plot you may find

that this scale isn't ideal, then you

should try out one of the smaller scales. Similarly if you are working on a large garden or a 

landscaping project you may find that an even larger scale works better. While you can happily 

switch between scales when planning it is generally better to choose an appropriate scale for you 

plan at the start and stick to that scale. 

NB: if you have labels in your plan and change scale the labels will also be resized along with all 

the plants etc. If this makes the labels difficult to read just save your plan and then reopen your plan.

NB: the scale values shown are absolute scales (also known as unitless scales). So 1:100 means one

inch on screen is equivalent to 100 inches in the garden. Some architectural plans use other scales. 

The scale values are based on a standard modern screen resolution. The values would vary if the 

screen resolution is higher or lower. Plans are printed to fill the screen and so the scale will vary 

when printing depending on the size of the plan and the paper.

Object Display Settings: The object display settings.... option allows you to determine if shadows are

shown on the plan or not (nb: shadows can also be turned off and on using the shadows button on 

the tool bar). You can also set the direction of the shadows - for example: if you want to make it look

like the sun is shinning from one side of your plan then you would change the direction of the 

shadows to point in the opposite direction 

This also option allows you to change how trees are displayed, allowing you to determine if you 

show the normal tree symbol or just an outline or a transparent tree. This setting is particularly useful

if you have large trees on your plan and you want to see plants that are under the trees. For a more 

advanced way to change how trees and other objects are displayed please use the Layers button. 



Auto Label Settings: The Auto Label

Settings... option allows you to

change settings associated with auto

labels (auto labels are described

above in the properties window

section).

You can change the font size used for

auto labels, so you can make the

label text larger or smaller. You may

wish to change the font size to

improve readability if you working

with a very large or very small plan. 

You can also choose to show a whit

background behind the labels, which can make it easier to read them especially if they are on top of

a dark object (like a lawn).

Finally, there are three buttons that may save you some time. These buttons let you turn on auto 

labels for all objects in your plan, or just plants or turn off auto labels. This is just the same as if you 

were to select each object individually and click its show auto label box.

Advanced Settings: The Advanced Settings... option allows you to change some more advanced 

settings of the application. 

You can set change how the application acts when it starts up. The show welcome message on start 

up option allows you to choose if you want the welcome message (which displays the options; start a

new plan, open a plan, open a sample plan or watch the animated introduction) to be displayed or 

not.

The start with window maximized option allows you to choose if you want Garden Planner to be 

maximized on start up. 

The show anchors (dots) when a path or shape is selected option lets you determine if you want to 

see the anchors on tool objects created with tools. These anchors are useful because they allow you 

to resize and reshape the tool.

The hide logo in print out option simply allows you to not include the Garden Planner logo in your 

print out.

Advanced 3d settings: See the manual for the 3d view for details.

The Selected Object Menu

The selected object menu allows you to access options for the currently selected object. If no object is

currently selected then the menu will not function. To enable the menu just select (click on) any object

on the grid.

Duplicate: this duplicates the currently selected object on the plan. This is the same as pressing the 



duplicate button on the toolbar.

Delete: this deletes the currently selected object on the plan. This is the same as pressing the delete 

button on the toolbar.

Duplicate in a line : this duplicates the currently selected object multiple times in a line. It can be 

really useful when creating plantings as it lets you set the spacing and direction of the plants in the 

line. 

Bring to front: this affects the stacking order (depth) of the currently selected object. Choosing this 

option moves the object to the top off all objects on the plan, irrespective of the type of object. 

Bring forward: this also affects the stacking order (depth) of the currently selected object. Choosing 

this option moves the object to the top off similar objects on the plan. For example: if a shrub is 

selected and you choose this option, the shrub will appear on top of all other shrubs but still beneath

trees. 

Send backward: this also affects the stacking order (depth) of the currently selected object. Choosing

this option moves the object to the bottom off similar objects on the plan. For example: if a shrub is 

selected and you choose this option, the shrub will appear below all other shrubs but still above 

garden beds. 

Send to back: this also affects the stacking order (depth) of the currently selected object. Choosing 

this option moves the object to the bottom off all objects on the plan, irrespective of the type of 

object.

Flip Horizontally: if an object created with the drawing tools is selected (like a garden bed or fence) 

this will let you flip the design horizontally, to give a mirror image of the design.

Flip Vertically: this works the same as flip horizontally however it flips the design vertically.

Copy shape :copy the shape of a the selected object if that object was created with the drawing 

tools. You can then Paste the shape you copied onto another drawing object and that drawing object

will now change to match the copied shape. 

Add to My Objects: this will add the selected object (or objects) to your My Objects collection: see My

Objects below 

Group: if more than one object is selected this will group the selected objects together as one new 

object.

UnGroup: if an object is selected that is a group then this will seperate it back to the original objects.

Select All: this selects all the objects in the plan. With all objects selected you can then move all the 

objects together or duplicate al the objects or delete all the objects.



My Objects

My Objects allows you to add your own customized objects to the 

Objects Panel. To see your 'My Objects', choose the My Objects 

category from the Objects panel (it will be the last one in the list). 

Initially My Objects will be empty. Select an object on your plan 

that you want to add to My Objects and then choose Add to My 

Objects from the Selected Object menu. The object will appear in 

the My Objects category. You can now just drag that object from 

My Objects to your plan. The objects you put in My Objects will 

stay there next time you use Garden Planner and can be used 

across different plans. It allows you to create your own library of 

custom objects. You can also select multiple objects and add them

to My Objects as a single object.

To delete an object from My Objects right click (or Control click 

on a Mac) and you will see a menu option appear saying delete. Click on this to delete the object.

For example: say you are regularly using garden beds of a fixed size in your plan, then you can 

draw one garden bed, select it and choose Add to MyObjects from the Selected Object menu. Then 

your custom garden bed is now part of your garden planner library.
 
 

The Help Menu

The help menu contains help and program information for Garden Planner.

Help Manual: this document.

Guide to using MyPlans: a simple guide to using the my plans menu.

GardenPlanner web site: a link to the Garden Planner web site.

Contact Us: a link to the Garden Planner Contact form.

Video : Getting Started with Garden Planner : will open a link to a gettting started video on the 

garden planner web site

Recover Last Plan: if you have lost your plan or unable to open your plan this option lets you open 

the back up save made by Garden Planner of your last work.

Languages: options to change the language used in the plant and object list.

Check for Updates: check to see if you have the latest version of garden planner.

About: shows the application version information and your license key.

Thank you's: show a message thanking people for their help in the development of Garden Planner.

Show 3d View :this turns on the 3d view tab. More about the 3d View see below

file:///C:/David/help/help3dview.html


Selecting Multiple Objects

You can select more than one object at the same time by holding down the Shift key while you click 

on the object to select it.

Alternatively you can 

When you select multiple objects the properties panel will change to show that you have selected 

multiple objects. It will display keys that let you move all the objects together. Alternatively you can 

use the keyboard to arrow keys to move the selected group of objects. You can move, resize, 

duplicate and delete multiple objects at the same time.

 

Creating Vegetable and Herb beds with the Create Veg. Patch tool. 

When you click on the Create Veg. Bed button on the tool bar (or choose Add vegetable patch from 

the Add Menu) you will see the following Window.

 

The process of adding one or more vegetable beds involves three simple steps. 
First: pick what you would like to grow.
Second: define the size of the garden bed.
Third: layout the vegetables / herbs.

Note: you can create multiple beds using the same list of plants.

Lets look at these three steps.

Step 1: Pick the vegetables and herbs you wish to grow

What you are doing is adding vegetables from the collection on the left to the My Vegetables list on 

the right. To get started click on a vegetable you would like to grow. You will see the details of this 



vegetable in the blue area below the list of vegetables as shown below.

 

Click on the Add button to add this vegetable to your list. It will appear in the list as shown below.

You can add more Vegetables to your My Vegetables list by selecting 

them and clicking on the Add button. If you wish to quickly add 

Vegetables you can double click on a Vegetable add it will add it 

directly to the My Vegetables list without needing to use the Add button.

If you click on the Herbs tab you will see a list of Herbs that you can 

also add to your My Vegetables list.

At present Garden Planner has just a selection of the most popular 

vegetables and herbs. If you can't find a vegetable you are looking for 

or want to have different variety of an existing vegetable you can do 

that by customizing the existing vegetables.

To create a custom vegetable first select the vegetable that has a 

symbol that best represents the vegetable you want to add. Then in the 

blue section you can customize the details to match what you require. 

You can select the color button to change the vegetables color. Move 

your mouse of the vegetable's name and you will be able to click on it 

and change the name. Move your mouse over the spacing and you will

be able to click on it and change the spacing between plants to 

whatever you require. 

To change the name or spacing of a vegetable from the My Vegetables 

list right click (or Control click on a Mac) and you will see menu options

to Edit or Delete. Click on Edit and a small window will appear that lets

you change the name and spacing for the selected vegetable. Chnage 

the name or spacing as required and then click ok. Please note: 

changes to the name are updated immediately across all garden beds 

using this vegetable. Changes to spacing are not automatically 

updated and you wont see these changes until the next time you open 

the plan. 

To remove a vegetable from the My Vegetables list right click (or 

Control click on a Mac) and you will see menu options to Edit or 

Delete. Click on Delete to delete the vegetable.

Once you have built up a list of vegetables and herbs that you wish to grow click on the Next button.



Step 2: Set the size of the vegetable bed

Next you set the size of the vegetable bed (patch). To make things easier a number of popular sizes 

are included in a list on the right hand side. You can just click on one of the popular sizes and the 

garden bed will change to that size. Alternatively you can enter in a specific size for your garden 

bed.

 

Note: you can always come back and change the size of the garden bed and you can use the same 

My Vegetables list to populate multiple different garden beds, so don't need to create one giant bed 

to fit in everything (although you can if you want). When you have the size set click the Next button

Step 3: Layout the Vegetables (and/or herbs)

The vegetable patch builder uses a simple grid to help you layout your vegetables.



 

To add vegetables or herbs to your plan first select the vegetable or herb from the My Vegetables list 

on the left. Then click on a square on the grid to add the vegetable. To add more than one planting 

of a vegetable to your bed just click and drag - it's a bit like painting with vegetables. If you make a 

mistake you select the Erase button and clear off any squares you wish and start again. 

The size of the grid squares is set to 1 foot (or 30 cm) by default. If more than one plant can be 

placed in a 1 foot square then a number will appear next to the plant indicating the number of 

plants per square. If a plant takes up more than one square it will be obvious when placing the 

plant how many squares it requires by the size of the blue square that appears when placing a 

plant. 

On the preview screen - Step 2 - you can change the size of the grid squares if required.

Click the Done button to create your garden bed and add it to your plan.

The Save Image button lets you save just your vegetable bed as an image.



To change an existing vegetable bed simply select it in your
plan then on the properties window select the Edit 
Vegetable Bed button.
This will re-open the window that lets you add or remove 
vegetables from the vegetable bed.

The Vegetables and herbs contained in all of your vegetable beds will appear in the 
Plant & Object List in the Notebook as shown below.

 



Resizing and reshaping objects created with the tools. 

After you have created an object with one of the tools, eg: some ground cover, or a path. You can 

then modify what you have created by selecting the object and dragging the coloured circles at the 

edges of the object.

The picture to the left shows paving that has been drawn using the 

paving tool. As you can see, when selected blue and green dots 

appear on the edge of the paving. The blue dots can be dragged to 

change the position of the corners of the paving. 

The green dots can be dragged to curve the edge of the paving.

It works the same way for walls, fences, paths etc. The blue dots 

adjust the corners, the green dots curve the shape.

If you right click on a blue dot you will see an option to Remove the 

Point - if you select this then the corner will be removed. For example

if you have a square lawn and remove a corner the lawn will be drawn with that corner removed 

and hence will be a triangle. If you right click on a green dot it will allow you to reset the curve, 

which effectively places the green dot back half way between it's to neighboring blue dots (ie: turns 

the curve back into a straight line). At present removing a point can not be undone.

If you right click on a shape, path, garden bed, paving etc you will see an option to add a New Point

Here. This will add a new corner to your shape or path with a new blue dot you can drag to re-

shape the object. 

 



How to use the 3D View in Garden Planner

Garden Planner version 3.6 and higher includes an option to turn on 3D view, allowing you to see 

your plans in 3D. 

The 3d view will translate your 2d plan into a 3d world you can walk around. Why is this an option 

that you activate from the Help menu? Because at this stage the 3d view is still being developed with

more objects and features being added regularly. So we are letting users choose if they want to use 

it right away (while there still a few objects missing) or you can wait for the final version that will 

come out soonish. Either way the 3d view, and all future updates are free for anyone who purchases

garden planner.

Want to try out the 3d view: Here's how:

You turn on the 3d view from the Help menu. Simply select Show 3d view from the Help menu.

This will result in a new green tab being visible: 3d view

You can then click on the 3d view tab to view the current plan in 3d. The image below shows one of 

the sample plans in the 3d view.



You can change where you are looking by clicking and dragging. To move use the arrow keys 

(cursor keys) to move forward, backwards, left and right.

To move the camera up use X 

To move down use Z

On the left of the 3d view you will see the 3d settings. If nothing has been selected you will see the 

general settings shown to the left.

Here you can change the appearance of the sky by clicking the 

blue arrows.

You can also adjust the position of the sun by dragging the 

yellow circle. Please Note: at the moment Garden Planner does 

not display ground shadows. 

You can also adjust the speed at which water in ponds and 

pools animates. Obviously this only matters if your plan 

includes water. 

 

You can also set if trees move slightly as if there is a slight 

breeze.

Below the settings are buttons that let you move around the 

garden, This provides an alternative to using the arrow key to 

move forward and the z and x keys to move the camera up and

down. This onscreen control can be useful when using garden 

planner on a tablet. 

 

 

 

 

If you click on an object or plant within the 3d view you will see 

the 3d settings for that object. At the most basic level this will 

display the objects name and it's elevation. The elevation is how

high off the ground the object is.



For a large number of Objects and Plants you will also be able to adjust the height within the 3d 

settings. 

If you are viewing a plan that was created prior to version 3.6 it is 

quite likely that you will need to adjust the height of some plants as 

they will probably be set to a default value that is a bit too tall. The 

reverse will probably be true for walls and trees added in an older 

plan, where they will probably be a bit short. Luckily its very easy to 

change the height of objects, just click on the object and then enter 

a new height in the 3d settings. Or if you wish you can change the 

height in the 2d view.

NB:sometimes it can be a little tricky to select an object in 3d. You 

may think you are clicking on the object but all you end up selecting 

is a near by tree or fence. Generally if you find it hard to select 

something the best tip is to move so you are standing above the 

object and look down at it and then click on the object.

 

 

 

 

 

For some objects you will also see an option that lets you adjust the style of the object. This may be 

the type of leaves on a plant, or the shape of a tree, or the type of flowers. 

The idea is that over time more and more plants and objects in 

Garden Planner will have one or more style settings that you can 

change. So along with being able to the change the size, height 

and color of plants you will also be able to change the 3d style of 

the plant (or object). It will make it easier to adjust the look of a 

plant to match the plants in your garden - even if you dont know 

the name or species of plant. All you need to do is pick the leaves,

the color and set the size. 

 

The follow terrain option below the elevation determines if the 

plant or object is placed on top of the ground below it. For 

example: if you place a plant on top of garden bed then the plant

will appear on top of that garden bed. But there may be cases 

where you don't want that. Maybe you want a wall to be half 

above and half below the bed. In that case turn off follow terrain 

and set the elevation value to what you require.

 

Below the properties you can adjust the position of the selected 

object with the on screen arrows. Please note these are in relation 

to the objects position on the 2d grid and not in relation to the 

current view. This means that the movement of the object may not 

be in the direction you expect. Just try out the arrows until you find



what you need. It may seem confusing but it works this way to ensure that objects are still aligned 

with the original 2d grid design. 

 

In 3d view there are a some different buttons on the tool bar.

 

The terrain button will add lines on the ground top make it easier to get a sense of ground layout.

The save 3d view button saves an image of the current 3d view. You can set any size for this image, 

but by default it will use the size of your current screen. Please note: if the image size is greater than 

4000 then it may take a few moments to create the image.

The Precise Selection button allow you to turn on or off precise selection in the 3d view. With this 

button on you should be able to select objects in the 3d view easily even if one objects is partially 

obscuring the other object. However this precise selection can be a lot of work for your computers 

processor which may result in the 3d view running slowly. So if you notice that the 3d view is running

slowly try turning off precise selection and only turn it on when you need it (ie: when you are finding 

it hard to select a specific object) 

 

At this stage the 3d view is still being developed. Please check for updates, provide feedback and 

watch as it grows better every day (or at least each week)

 



 
Appendix A : Keyboard shortcuts

On the Macintosh the Command Key is used instead of the Ctrl Key 

Delete key 

(or Crtl + X)
deletes the currently selected object

Crtl + A select all

Ctrl + D duplicates the currently selected object

Ctrl + H show help manual

Ctrl + N create a new plan

Ctrl + P print

Ctrl + O open a plan

Ctrl + S save

Ctrl + Q quit

Ctrl + Z Undo

Ctrl + Y Redo

Ctrl + 1 switch to Select mode

Ctrl + 2 switch to Resize mode

Ctrl + 3 switch to Rotate mode

Tab
move from the currently selected object to the next 

object 

Shift + Tab
move from the currently selected object to the previous

object

Arrow Keys

move the selected object slightly up, down, left or right

(hold down Shift while pressing an arrow key to nudge

object)


